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System Requirements

The following information outlines the minimum and recommended system requirements to run Micromine
Alastri Production Scheduler. As the hardware required depends on the complexity of the mine and the
amount of data, meaningful minimum requirements cannot always be listed. Ultimately the only way to
know whether specific hardware will work for a specific mine site is to validate the software's performance
during the free trial period.

For large multi-pit mines with raw LIDAR surfaces and block models with 80M blocks the requirements
will be at the extreme end.

The minimum requirements will only support small mines with a small block model and surfaces with low
triangle counts.

Please note that as our software develops over time, these requirements may change, and hardware
upgrades may become necessary.

Note: Running Alastri Production Scheduler on minimum system requirements may slow the application
response, depending on the size of the model. Use recommended requirements for optimal use.

Component Minimum Standard Extreme

Processor Intel i5 Intel i7 Intel i9

Memory (RAM) 8 Gb 64 Gb 128 Gb

Operating System Windows 10 Windows 10 x64 Windows 10 x64
x64

Video Memory (GRAM) | 2 Gb 8 Gb 12 Gb

Monitor 1920 x 1080 Dual 1920 x 1080 Triple 1920 x 1080

Video Connection HDMI, DisplayPort, DVI, VGA - USB not supported

Video Driver Driver no more than 6 months old (OpenGL 4.6+)

Hard Drive Solid State Drive with at least 50 GB Free

Power Connection AC Power - Battery power not supported (plug in the laptop)

Network Connection Consistent, reliable, high speed (>1 MB/s)

connection to the Internet
Software Prerequisites | .NET 4.7.2

Microsoft Visual Studio 2019 C++ Redistributables
(nttps://aka.ms/vs/16/release/vc_redist.x64.exe)

Microsoft Excel
Input Devices Keyboard and Mouse with a left mouse button, right mouse button, and
middle mouse button/scroll wheel

"Element Not Found"

Many IT departments block downloads of Microsoft prerequisites, so you may need to download them
manually.
The installation error "Element Not Found" indicates that you must download and install these manually.

e Microsoft .NET Framework 4.5.1
e Microsoft VSTO Runtime for Office 2010
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Installationand Setup

It is important to note that the System Requirements should be met to run the software.

If any error whatsoever occurs on install, ensure that you have downloaded and installed these
manually.

e Microsoft .NET Framework 4.5.1

Production Scheduler requires Windows 10 or higher (64 bit only)

Follow these steps to get started with Alastri Production Scheduler.

New users may proceed to the licensing page and click Register as a new user. Please check your
inbox for a confirmation email to finalise your account.

¢ alastri

# Dashbosrd

Choose from the following options to license your account with chosen Alastri products.

e Askyour manager to log inas a License Admin and add you to the company license, or
e Email support@alastri.com.au for assistance.

The Hub manages all Alastri product release versions and licenses. It can be downloaded by logging
into the licensing page and pressing Download Hub.
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Once the Hub has finished downloading, run the executable and click Confirm on security prompts to

continue the install.

4 Alastri Hub 2.0.82.0 (x64)

E Alastri Hub 2,0.82.0 (x64) Setup — >

END-USER LICENSE AGREEMENT Revision 2.0- 22 April 2020 ~

Impartant - Read carefully:

This End-User License Agreement ("EULA") is a legal agreement between and
binding each person using Alastri's software (“you” and “User”) and Alastri
Software Pty Ltd (“Alastri"). It applies to all Software Products made available

| agree to the license terms and conditions

Opticns & Install Close

Note that Alastri products will always be signed with "Verified Publisher: Alastri Software Pty Ltd".

Wait until the download is complete and click Close.

&
=10 Alastri Hub 2.0.82.0 (x64)

Installation Successfully Completed

Cloze

Even if you have administrative privileges, you should install the Hub by right clicking on the
Alastri.Hub.2.0.*.exe file and run as administrator.
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Double click on the Hub shortcut, or click Start > Alastri Hub, to open the Hub login form.

¢ Alastri Hub v2.0.77

¢;: alastri

Emad: | alastri.user@gmad.com
pé‘;S‘.‘.O’d: SRR RRORNS
Remember my password Logn Cancel
Forgot your login detads? Reset Password
Don't have an Alastn account? Create a New Account

Enter your email and password into the login form and press Login to continue.

The Hub uses the same password credentials as the licensing website. Passwords can be reset here.

If you are connecting through a company proxy, press Proxy Settings in the bottom right corner of the
login form.

¢ Alastrd Hub v2.0.77

alastri

Ermanl:

Password: EEREEEEERAEERREE
Remember my password | o LG Carcel

Forgol your logn cetals? Rt Pagaword

D't vl 5 Alag i poCsnt? Creane & Mew Aoooin

Proncy Settings. b

Chear Cache
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Contact your IT department to obtain the correct proxy credentials for your organisation.

In the main Hub form:

1. Select Production Scheduler from the left hand product menu.
2. Select the latest version.
3. Press Install.

LGl Downloads Alastri Hub v2.0.82 ® Request Support M Alastri= £ |ana Armstrong» —

m Haul Infinity
@Wmmm, | P Production Scheduler

m Rapid Reserver Production Scheduling Software for Open-Pit Hard Rock Mines

% Options - Extended Checkout
E Spatial Conformetrics

7 of 10 Seats Available
Tactical Scheduler
Current Active Users Time

Gemma O'Farrell
Karl Wellwood

Scott Pernich

You've been planning with this product for 251 hours

Version
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Graphics & Compatibility

Followthese steps to ensure Production Scheduler runs smoothly on your computer. Note that your
screen and settings may differ from those shown here.

Production Scheduler requires a dedicated graphics card by NVidia or ATI to run. To check your graphics
card, go to Windows Start > Control Panel > Hardware and Sound > Device Manager > Display Adapters.

% Hardware and Sound — O X

« v P E_E » Control Panel » Hardware and Sound » v O Search Control Panel 2

Control Panel Home c .
./ Devices and Printers

Add a device | Advanced printersetup | Mouse | W9 Device Mangger
Change Windows To Go startup options

A
|
-

Systemn and Security

MNetwork and Internet
¢ Hardware and Sound @ AUtDPIay

Change default settings for media or devices | Play CDs or other media autematically

Programs
Uzer Accounts (Q) Sqund . |
"/ Adjust system volume | Change system sounds | Manage audio devices

Appearance and
Personalization W‘Q Power Options
Change battery settings | Change what the power buttons do
Require a password when the computer wakes | Change when the computer sleeps
Adjust screen brightness

Cleck, Language, and Regicn

Ease of Access

t] Display
<=4 Make text and other items larger or smaller | Adjust screen resolution
How te correct moeniter flicker (refresh rate)

fal, Windows Mobility Center
_‘g Adjust commaenly used mobility settings | Adjust settings before giving a presentation

NVIDIA Control Panel

@ Alienware Audio

Open the Control Panel and search for the Device Manager
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M Device Manager
File Action View Help

&= m 0 BHE &

e Bluetooth
@ Cameras
8 computer
- Disk drives
v Lil Display adapters
Firmware
¥ Human Interface Devices
“® |DE ATA/ATAPI controllers
<% Imaging devices
E= Keyboards
L1 Memory technology devices
0 Mice and other pointing devices
[ Monitors
& Network adapters
= Print queues
= Printers
n Processors
7 Security devices
P Software components
B Ssoftware devices
i Sound, video and game controllers
C.'_‘ Storage controllers
£3 System devices
i Universal Serial Bus contrallers
= WSD Print Provider

Find the graphics card details listed under the Display Adapters

£\ Graphics Problem

If you are running a computer without a dedicated graphics card, then you will need to upgrade your
computer to run Production Scheduler.

If youdo have an appropriate dedicated graphics card, then proceed to the next step.

Alastri products require the latest graphics card drivers for best performance.

&) Outdated Graphics Card Driver

Driver for NVIDIA Quadro 6000 hasn't been updated since Wednesday, 27 May

2015.

You wil not be able to use this applicabon untll you update your drivers.

NVIDIA Drivers:

NVidia Driver Downloads

ATI Driver Downloads

Intel Driver Downloads

http://www.nvidia.com/Download/index.aspx?lang=en-us

Jd &

If you see this message, follow these links to download and run the latest graphics card drivers.
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Change the Default Graphics Processor

If any graphics related issues arise, navigate to the graphics card control panel and set Alastri products to
run in high-performance mode.

NVidia Graphics Cards

If you have a NVidia graphics card, it may be defaulting to the integrated graphics card instead of the
higher performance NVidia graphics card.

To change the default video card for Production Scheduler:

1. Right click onyour desktop and select “NVidia Control Panel”.

View
Sort by
Refresh

Paste
Paste shortcut
Undo Move

B NVIDIA Control Panel

New

™ Display settings

&Y Personalize

2. Select “Manage 3D settings”.
3. Select “Program Settings”.
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B NvIDIA Control Panel - O X
File Edit Desktop 3D Settings Help
e Back ~ O ‘ 7;\1
Select a Task... sflEaE . ~
5 30 Settings .. Manage 3D Settings
Adjust image settings with preview g Restore Defaults
You can change the global 3D seftings and create overrides for specific programs. The overrides will |
Configure Surround, Physx each time the specified programs are launched
= Display
-Change resolution . i
Adjust desktop color seftings I would fike to use the following 3D settings:
Rotate display
View HDCP status Global Settings Program Settings
Set up digital audio
-Adjust desktop size and position 1. Select a program to customize:
-Set up G-SYNC 3DMark (3dmark.exe) = Add Remove “2 Restore
& Vwizt up multiple displays Show only programs found on this computer
! -Adjust video color settings 2. Specify the settings for this program:
Adjust video image settings Feature Setting ~
Image Sharpening Off
Ambient Occlusion Not supported for this application
Anisotropic filtering Use global setting (Application-controlled)
Antialiasing - FXAA Mot supported for this application
Antialiasing - Gamma correction Use global setting (On}
Antialiasing - Mode Use global setting (Application-controlled)
Antialiasing - Setting Use global setting (Application-controlled)
Antialiasing - Transparency Use global setting (Off)
Background Application Max Frame Rate Use global setting (Off)
CUDA - GPUs Use global setting (All)
Low Latency Mode Use global setting (Off)
Max Frame Rate Use global setting (Off)
Monitor Technoloay Use alobal setting (G-SYNC) v
v
[@ System Information a 5

4. Choose “Production Scheduler” from the dropdown menu.

e Or navigate to %localAppData%\Alastri
Hub\Programs\PROGRAM\VERSION\3DMARK _.exe.

5. Select your NVidia graphics card under "preferred graphics processor".

If you are using an ATI graphics card, it may be defaulting to the integrated graphics card instead of the
higher performance ATl graphics card.

To change the default video card to Production Scheduler:

1. Right click onthe desktop and open Catalyst Control Center.
2. Select “Power” from the left hand menu.
3. Select “Switchable Graphics” from the list.

4. Browse the list of programs and find ProductionScheduler.exe (or C:\Program
Files\Alastri Software\Alastri ProductionScheduler v21.2.981\
ProductionScheduler.exe).

5. Set ProductionScheduler.exe to “High Performance”.

6. Apply changes and restart your computer.
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These notes apply if you are importing surfaces from Maptek Vulcan. Production Scheduler requires
Vulcan surfaces to bein file format version 7.5 or earlier in order to import and use them.

In Vulcan, go to Tools > Preferences > File Types > Triangulations and change the file format to Version
7.5. Vulcan requires a restart for the changes to take effect.

If youdo not want to change Vulcan's formatting, use File > Export to DXF and import to Production
Scheduler as a DXF file.

Workbench Triangulations
é-\u‘_ulcan Explorer File Extentions
(= File Types [¥] Auto update

. Grids

Extension | Use
00t
Bt
dat

Envisage
Dialogs and Popups
EI Graphics
Input
i Colours out
- Effects
i Video Capture
—)- Defaults
2D Text
(3D Text
i Arrow

* k| W A e
EEEaE

i Dimension
- Miscellaneous
- Paths/Directories
- Plot All File Format
- Dragline Select format requires a restart of workbench to take effect.
Ramps
- Drill 8 Blast
- Draw by Hand
Plotting Utility

| o [ e ]

Production Scheduler requires Vulcan triangulations to be version 7.5
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These notes apply if you are importing surfaces from Geovia Surpac. Production Scheduler requires
Surpac surfaces to be saved in text format in order to import and use them.

Error{s) Encountered

x One or more files had problems in them as follows:

1: topo_final.dtm =3 Index was outside the bounds of the array.

This error message is caused by trying to import a Surpac DTM in binary format

Save File *

Layer Mame topao_Final.dtm

Filename d:ltopo_ﬁnall I
Qutput Farmat Type | Surpac DTM Files ~
Extension | .dtm v
Options...
Fil= Format @) rext DTM[30DM Options
() binary Force solid validation on save
String Range Force rigid backwards compatibilicy
Purpose

Save styles [
Styles file name 5S1_STYLES:skyles,ssi

) 3 e

When saving surfaces in Surpac, set file format to text

To prevent laptops from switching back to Intel graphics on lower power mode, go to Power Options >
High Performance > Advanced Power Settings and change all options to maximum performance.

Alastri recommends saving all project files and data onthe local hard drive before transferring to the
network. This avoids issues with saving over interrupted connections or reading from a slow connection.
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Licenses may be used offline by using the Extended Checkout feature in the Hub.

In the main Hub form:

AP wDDE

Press OK

Products VGG
m Haul Infinity

E Production Scheduler

m Rapid Reserver

G Spatial Conformetrics
Tactical Scheduler

Select an item from the left hand product menu.
Press Extended Checkout.

Enter the hours to checkout the license.

@ Request Support M Alastri~ £ lana Armstrong~ —

P Production Scheduler

Production Scheduling Software for Open-Pit Hard Rock Mines

%, Options ~ Wl & Extended Checkout

7 of 10 Seats Available
Production Scheduler Extended Checkout

Use this form to check out the license for an extended duration.

Note that you cannot check a license back in early - it will

irrevokably be locked out for the duration of the checkout period that you
specify.

Checkout Duration (hours) m :

# cancel v oK

‘You've been planning with this product for 251 hours

Version: 21.2.981

Release Notes

v' This will lock the license to your machine (online and offline) for the duration of the checkout.

Note that license cannot be checked back in until the timer runs out.

Users may encounter the "Access is denied" error message when attempting to open a project file via the

Hub or from Windows Explorer.

Stack Trace: System.ComponentModel.Win32Exception (0x80004005): Access is denied
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This error occurs when the helper process "PolygonicaService.exe" is blocked from running by a virus
scanner, group policy, or Windows compatibility profiles.

Virus scanners may block PolygonicaService.exe, or prevent it from launching. Adding a whitelist /
exception for this process can help avoid "Access Denied" errors.

The Alastri Hub installs products into the following location: %localappdata%\Alastri Hub\Programs.

Occasionally group policy configuration may prevent applications from being launched from
AppData\Local on machines.

Your IT administrators may need to provide an exception for Production Scheduler to allow it to operate
correctly.

In order to allow legacy software to work on your system, your IT department may have created a
program compatibility profile which causes Windows to run applications with non-standard behaviour.
This can affect Production Scheduler’s ability to track instances of PolygonicaService.exe and make sure
they are cleanly shutdown with the application.

Your IT administrators may need to modify the application compatibility profile to avoid affecting
Production Scheduler.

Users may encounter the "Application Compatibility Profile" warning when attempting to install the Hub.
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Application Compatibility Profile Detected

We have detected an application compatibility profile on your machine,
' % which may interfere with installation of Alastri Hub,

Would you like to disable this profile?

Keys found:

SOFTWARE\Microsoft\Windows
NT\CurrentVersion\AppCompatFlags\Custom\\HKEY_LOCAL_MACHIN
E\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\AppCompatFlags\Custom\setup.exe

Serious problems might occur if you modify the registry incorrectly. Contact your IT department to resolve
this issue.

IF YOU ARE A COMPETENT IT PROFESSIONAL:

This issue may be resolved via the following steps:
1. Click on Start, typein "regedit" and run the command.

2. Browse to ComputenHKEY_LOCAL_MACHINE\SOF TWARE\Microsoft\Windows
NT\CurrentVersion\AppCompatFlags\Custom.

3. Rename setup.exe to _setup.exe.
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Project Files

When Production Scheduler is saved, multiple different files will appear in the save location.

.psch
Jock

.old
.resultCache

layers

.drapelmages

Production Scheduler project file

Locks out a file to one user at a time

If the main project files are corrupted for any reason, the “.old” files can be restored
as functional project files by removing “.old” from the file name

Reduces scheduling time by saving results of previous runs

Saves triangulations external to the main project. Deleting the “.layers” file is the
same as deleting all layers from the project

Saves draped images external to the main project. Deleting the “.drapelmages” file is
the same as deleting all draped images from the project
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Internet License FAQ

Alastri software uses standard Internet-based authorisation. If you are in a remote location with a poor
connection, or no internet connection at all, then you may wish to enquire about dongle based
authorisation.

The internet license authenticates your purchase key, name and email against your details on the Alastri
server.

The license does not require any special software to be installed.

The licensing dialog will inform you of any authentication errors.

You can use the Extended Checkout feature to hold licenses offline for a number of hours. Normally the
maximum checkout time for licenses is seven days.

Checked out licenses cannot be released before their expiry date.

| Alastri Licensing — e )

Licence Details

Purchase Key (ABCD-EFGH-1IKL-1234-5678)
MINE-ROCK-TECH-SERV-ICES

Your Name (First and Last Only)
Mine Rock Technical Services

Your Email Address
support@alastri.com.au|

License Server

www.alastri.com.au

Get Licence

Extended Checkout

Requested Length in Hours
43

Note: Extended check-outs can't be checked-in early

Proxy Settings
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Internet License Troubleshooting

Your IT department may be restricting applications from connecting to the internet. In this case, Alastri
connects through a browser instead. Talk to your IT department about network permissions for Alastri

products.

The internet license authenticates your purchase key, hame and email against your details on the Alastri
server. Check for spelling errors in your name; if problem persists then contact Alastri support.

Licensing X
Error returned: Invalid Licence Details - Full name does not match user's last full name

Press OK to open the licensing page in your browser, or Cancel to change your details.

..................................

OK Cancel

.................................

The internet license authenticates your purchase key, name, and email against your details on the Alastri
server. Check for spelling errors in your email, if problem persists then contact Alastri support.

Licensing X
Error returned: Invalid Licence Details - alastri.com.au user profile with given email address was not found.

Press OK to open the licensing page in your browser, or Cancel to change your details.

Cancel
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Each Alastri license can be shared between a number of users. Ask your colleague if they can release
the license for your use.

Licensing X

Error returned: Invalid Licence Details - Floating license does not have any available seats.

Active Users:
Tim F,

Press OK to open the licensing page in your browser, or Cancel to change your details.

Cancel

The internet licensing system checks to make sure that the computer's date and time is correct, to ensure
that checked out licenses expire properly. If you see this message, make sure that your computer's date
and time is updated.

Save and close your project and talk to your supervisor about renewing your license.
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Hub Login Failure

If the user encounters the Login Failed form, please re-enter your correct username and password.
| Alastri Hub - Login Failed x

@ Invalid username or password. Check your details and ensure you have confirmed your email address.

..................................

..................................

Should the user forget their password, the Hub login form features the option for the user to Reset the
password (Reset Password button). This will take them to the Alastri website where the user can enter
their email address. An email will be sent to the entered email address with a password reset link.

Alastri Hub v2.0.77

*= alastri

Email:
Password: SREAEEBERERERREE
Remember my password |+ Cancel
Forgot your login details? Reset Password
Don't have an Alastri account? Create a New Account
GDPR Notice Options  ~
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Forgot your password?

Enter your email address to request a password reset.

Email

™

reCAPTCHA

Privacy - Terms:

I'm not a robot

Email Link

If the user is unable to connect to the Hub due to connection loss, several steps can be taken to try and
rectify this.

If the user is presented with a Hub login screen that doesn't complete and seems to freeze, or a message
communicating No Connection, then most often the problem is on the user end with permissions
blocking access to the required files and web addresses.

50%
Getting Alastri products. .. Cancel

Forgot your login details? Reset Password
Don't have an Alastri account? | Create a New Account

Confiqure Proxy. ..

Alastri Hub - No Connection X

Unable to establish an Internet connection. If you require a proxy, please configure it and try again.

Would you like to start the Hub in Offline mode?

Offline Mode Cancel

Please try the following in order:

1. Open afile explorer.

2. In the file path, type the following “%localappdata%”.

3. Go into the Alastri Hub Folder.
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4. Go into the Cache folder.
5. Delete the contents inside.
6. Restart the Hub.

To try and resolve this you will need to get IT to add https://alastribuild.azureedge.net/ to the
whitelist.

Virus scanners will also need to allow Alastri access to the following address:
C:\Users\username\AppData\Local\Alastri Hub.

Try access the following link https://alastribuild.azureedge.net/media/rr/background.jpg. You
should see an image of an open pit operation.

Repeat Steps 1-6.

If you use a proxy you will need to enter the details.

Repeat steps 1-6.

If your IT team tell you they have an auto proxy and you still can't login, tell them to try specific
proxy for your machine.

Repeat Steps 1-6.

Contact Alastri.
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Dongle License FAQ

Alastri software uses standard Internet-based authorisation. If you are in a remote location with a poor
connection, or no internet connection at all, then dongle authorisation may be the best solution for your
needs.

Please contact Alastri Support to discuss your requirements.

The dongle does not require any special configuration to use. Simply insert the dongle into a USB port on
the computer and use the application as normal. In a normal state after the dongle is attached to the
computer the LED will be on all the time.

Yes, every login requires authentication of your purchase key, name, and email address.

The dongle does not require any special software to be installed.

A single dongle is required per computer per license key. It is possible to share one license across
multiple dongles. Contact Alastri Support to discuss your requirements.

Contact Alastri Support to discuss replacing your dongle.

Once a dongle is recognised by the computer, the dongle ID will show in the licensing dialog.
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= Alastri Licensing = 0 x

Licence Details

Purchase Key (ABCD-EFGH-1IKL-1234-5678)
Your Mame (First and Last Only)
Your Email Address

License Server

www.alastri.com.au

I.ﬁ.lastri Licensing Dongle detected: 137 I

Extended Checkout -

Proxy Settings -

You should only pull out the dongle once the software has been shut down.

If unplugged while writing/reading, your unsaved data may be lost.

There are times when dongles are not immediately recognised by the software or the computer. Take
these steps to check and resume the USB connection

The dongle LED indicates the status of the dongle. In a normal state after the dongle is attached to the

computer the LED will be on all the time. If the LED blinks it indicates that the driver is not installed. Other
LED responses indicate hardware failure.
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This problem occurs occasionally. Generally, your device is not attached properly to the computer, or
some interference exists. Remove your dongle and try to attach it again through a different USB port.

o wDNE

With the dongle inserted, exit, and restart the application.

Insert the dongle into a different USB port and restart the application.

With the dongle inserted, reboot your computer, and restart the application.
Insert a different dongle, then switch back.

Contact Alastri Support to exchange your dongle.
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